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8.1  PSD Quick Start

This section gives a quick overview of how to perform a 
PSD acquisition of angiotensin and an unknown in manual 
mode.

For detailed PSD information, refer to the sections that follow 
this PSD Quick Start.

Before you begin Before starting this PDS Quick Start, be familiar with the 
information in:

• Section 8.2.1, Post-Source Decay Analysis

• Section 8.6.1, Observing the Effects of Laser Intensity

• Section 5.1, Loading, Modifying, and Saving Instrument 
Settings

• Section 6.2, Acquiring in Manual Mode from the 
Instrument Control Panel

• Section 6.4, Making Accurate Mass Measurements

• Data Explorer User’s Guide, the sections that describe 
examining spectra and manual calibration

Two types of
calibration in PSD

analysis

When you perform PSD analysis, you generate two types of 
mass calibration:

• External calibration applied to precursor ion mass— 
Normal mass calibration applied to a reflector mode 
spectrum, to ensure accurate mass of the precursor ion 
(described in Section 6.1.3, Calibrating the Mass Scale).

• PSD calibration applied to fragment ion masses—
Special PSD calibration that optimizes fragment ion mass 
based on precursor ion mass and Mirror Ratio setting 
(described in Section 8.2.5, Mass Calculation for 
Fragment Ions).

Steps to perform
PSD analysis

The steps to perform PSD analysis on angiotensin and on an 
unknown are summarized in Table 8-1 and Table 8-2.
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Step Result
See 
page

1. Generate a Reflector mode precursor 
spectrum (use PSD_Precursor.BIC provided).

-6

2. Generate a normal single-point external 
calibration using the spectrum acquired in 
step 1. You use this single-point external 
calibration in PSD analysis to obtain maximum 
mass accuracy for the precursor ion.

-6

3. Set PSD Acquisition/Instrument Settings 
parameters—Open Angiotensin_PSD.BIC 
provided, and:

• In Instrument Settings—Type the 
angiotensin precursor mass and select 
Angio.CAL generated above (for 
precursor).

• In PSD Acquisition Settings—Select 
default PSD calibration (for fragments).

-6

4. Acquire PSD segments (precursor and 
fragment spectra).

-8

5. Generate a PSD multi-point external 
calibration using the spectrum acquired in 
step 4. You use this multi-point external 
calibration in PSD analysis to obtain maximum 
mass accuracy for the fragment ions.

-12

Precursor

Angiotensin Reflector spectrum

1296.6853

Angio.CAL

Normal external calibration 
for precursor ion mass accuracy

Angiotensin_PSD.BIC with:

Default PSD calibration
Angio.CAL

Angiotensin PSD Composite spectrum

10
9.

5

51
2.

9

Angio_PSD.CAL

PSD calibration 
for fragment ion mass accuracy
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6. To verify that the Angio_PSD.CAL yields 
acceptable mass accuracy:

• Add the PSD calibration generated in 
step 5 to PSD Acquisition parameters—
Open Angiotensin_PSD.BIC, select 
External PSD Calibration File, then 
select Angio_PSD.CAL (for fragments)

-13

• Acquire PSD segments (precursor and 
fragment spectra) with PSD calibration

-13

Step Result
See 
page

Angiotensin_PSD.BIC with:

Angio_PSD.CAL
Angio.CAL

Recalibrated angiotensin PSD 
Composite spectrum with optimum 

fragment ion mass accuracy

11
0.

1

51
3.

3
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Step Result
See 
page

1. Generate a PSD calibration on angiotensin by 
performing step 1 through step 6 in “Steps to 
Perform PSD Analysis of Angiotensin” on 
page 8-3.

8-3

2. Generate a precursor spectrum on the 
unknown in Reflector mode (use 
PSD_Precursor.BIC provided).

NOTE: This step assumes that you have 
already determined an accurate mass for the 
precursor ion using reflector mode 
high-resolution analysis with internal or 
external calibration.

-6

3. Generate a normal single-point external 
calibration using the spectrum acquired in 
step 2. You use this single-point external 
calibration in PSD analysis to obtain maximum 
mass accuracy for the unknown precursor ion.

-6

4. Set PSD Acquisition/Instrument Settings 
parameters—Open Angiotensin_PSD.BIC 
provided, and:

• In Instrument Settings—Type the 
precursor mass and select 
Precursor.CAL generated in step 3 (for 
precursor).

• In PSD Acquisition Settings—Select 
Angio_PSD.CAL generated in step 1 (for 
fragments).

-6

5. Acquire unknown PSD segments (precursor 
and fragment spectra) with Angio_PSD 
calibration.

-13

PSD calibration 
for fragment ion mass accuracy

Angio_PSD.CAL

Precursor

Unknown Reflector spectrum

??

Precursor.CAL

Normal external calibration 
for precursor ion mass accuracy

Angiotensin_PSD.BIC with:

Angio_PSD.CAL
Precursor.CAL

Unknown PSD Composite spectrum
with optimum fragment ion

mass accuracy
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6. Optionally, confirm or investigate fragment ion 
identity using the Ion Fragment calculator or 
the Peptide Fragmentation macro.

-18

Step Result
See 

page

Unknown PSD Composite spectrum
with fragment ion labels

H y2 b3
–1

7

a5 b6
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8.1.1  PSD Analysis of Angiotensin

Generating the
Reflector mode

precursor
spectrum

1. Open the PSD_Precursor.BIC file provided with the 
software. This is a reflector mode instrument settings 
(.BIC) file. All other instrument settings should be 
identical to the settings in the PSD mode 
Angiotensin_PSD.BIC you use later to acquire 
segments.

2. Acquire using a laser intensity that does not saturate the 
reflector spectrum.

3. Save the precursor ion .DAT file by clicking  in the 
toolbar.

Generating an
external

calibration for the
precursor ion

To obtain maximum mass accuracy for the precursor ion, 
follow the steps below to generate a single-point external 
calibration file to use when you perform the PSD acquisition. 

NOTE: This is not a PSD calibration that affects fragment 
ion masses. It ensures accurate mass of the precursor.

1. Click  in the Instrument Control Panel toolbar to 
open the precursor ion data file in the Data Explorer 
software. 

2. Create a single-point calibration using the precursor ion 
mass, then save the calibration file as ANGIO.CAL by 
exporting the calibration constants from the data file. For 
more information, see the Data Explorer Software User’s 
Guide, Section 5.3.2, Manually Calibrating.

Setting PSD
acquisition
parameters

1. Open the Angiotensin_PSD.BIC file provided with the 
software. This is a PSD mode .BIC file.

The PSD Acquisition Settings control page (Figure 8-1) 
is automatically displayed in the Instrument Control 
Panel if you open a .BIC file set to PSD mode.
8-6 Applied Biosystems
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Figure 8-1  PSD Instrument Control Panel with Acquisition Settings Control Page

2. In the Calibration section of the Instrument Settings 
control page, select:

• The matrix you are using. 

• External File, then select the ANGIO.CAL file you 
created in “Generating an external calibration for 
the precursor ion” on page -6.

External
.CAL file for

precursor

Default PSD
calibration for

fragments

PSD
acquisition

settings
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3. In the PSD Acquisition Settings control page, type the 
angiotensin Precursor mass.

NOTE: Precursor mass is used for PSD calibration. 
Type in an accurate value with appropriate precision 
(for example, type 1296.68, not 1297).

4. Ensure that PSD calibration is set to Default.

5. Select Save Instrument Settings As from the File menu, 
then save the instrument settings file with a new name.

NOTE: The instrument settings files provided with your 
system (PSD_Precursor.BIC and 
Angiotensin_PSD.BIC) are read-only. You cannot save 
changes to these files unless you assign a new name.

Acquiring PSD
segments

1. In the Manual Laser Intensity/Sample Positioning 
control page, select the same sample position from 
which you acquired the precursor spectrum.

2. From the View menu, select Data Storage. Set 
parameters as needed. See “Setting Data Storage 
parameters” on page 6-14 for information.

Hint: Include a _PSD suffix when you name PSD data 
files to help you distinguish them from non-PSD data 
files. For example, if you type in Experiment1_PSD as 
the file name, the complete data file name will be 
Experiment1_PSD.DAT or 
Experiment1_PSD_0001.DAT (if Autosequence File 
Names is enabled).
8-8 Applied Biosystems
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Selecting and
acquiring a

segment

3. In the PSD Acquisition Settings control page, select the 
first row (click the number box in the Segment column) 
that corresponds to the segment you want to acquire.

4. To start acquiring, select Start Acquisition from the 
Acquisition menu, or click . 

5. Adjust laser intensity to optimize signal intensity. You 
typically need a higher laser intensity to optimize signal 
intensity for segments with lower Mirror Ratio settings.

The laser intensity needed for the first segment (the 
segment with the highest Mirror Ratio setting) is 
typically 150 to 200 counts higher than the laser 
intensity used to acquire the reflector mode precursor 
spectrum, and increases with each subsequent 
segment.

Examining and
saving the segment

6. Examine the spectrum to ensure that fragments are 
produced (Figure 8-2).

Figure 8-2  Segment Spectrum

Fragments

Precursor
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7. If fragments are present and data is acceptable 
(Figure 8-2), click  in the toolbar to save the segment 
to the .DAT file. After you save the segment, the Saved 
check box in the segment list is checked.

If the current spectrum does not contain significant 
fragment ion signal and you do not want to save the 
spectrum, reselect the row and reacquire the spectrum, 
or select a new row.

CAUTION
Save the current segment (if the data is acceptable) 
before starting to acquire the next segment. If you do 
not, you will lose the data for the current segment.

Selecting and
acquiring

remaining
segments

8. Repeat step 3 through step 7 to collect remaining 
segments. 

NOTE: Segments are listed in the Data Explorer 
software in the order in which they are acquired. If 
segments with duplicate Mirror Ratios are contained in 
the file, the software uses the last acquired segment 
when it generates the composite spectrum.

Stopping the
experiment

9. After you acquire all necessary segments, select Stop 
Experiment from the Acquisition menu. The PSD data file 
is closed.

You cannot view the PSD data file in the Data Explorer 
software until you stop the experiment.

CAUTION
If you stop an experiment without saving any segments, 
no .DAT file is created.
8-10 Applied Biosystems
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Determining if PSD
calibration is

needed

1. Click  in the Instrument Control Panel toolbar to 
open the PSD data file in the Data Explorer. The 
software “stitches” together portions of the fragment 
spectra and displays a composite spectrum (see 
Figure 8-6 on page 8-26 for an explanation of how the 
software generates the composite spectrum). 

Your angiotensin composite spectrum should be similar 
to the spectrum shown in Figure 8-3.

Figure 8-3  Angiotensin Spectrum

2. Examine the masses in the stitched spectrum and 
compare them to the expected masses listed in Table 8-1.

1181.6
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 If masses are not within ±0.2 Da (STR models) or ±0.3 Da 
(PRO models) of the expected masses, generate a PSD 
calibration, and reacquire the PSD segments with the PSD 
calibration.

Generating a PSD
calibration

This section gives a brief description of how to generate a 
PSD calibration. For more information, see the Data Explorer 
User’s Guide, Section 8.3.3, Creating PSD Calibration (.CAL) 
Files and Applying to Other Data Files.

NOTE: This is a PSD calibration that affects fragment ion 
masses. 

1. In the Data Explorer software, open the PSD data file 
acquired in the previous section, if it is not already 
open.

2. From the Process menu, select Mass Calibration, then 
select PSD Calibration.

3. Select the Angiotensin_Fragments.REF file provided 
with the software.

Table 8-1   Expected Masses in Angiotensin Spectrum

Expected Mass Ion Type

110.08 His

255.16 b2–17

269.16 y2

354.20 b3–17

513.08 y4

619.36 a5

784.41 b6

1,181.6 y9
8-12 Applied Biosystems
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4. Select the peaks listed in Table 8-1 as reference masses 
for calibration by right-click-dragging on a peak, then 
select the correct mass for the peak in the Reference 
Peak dialog box. 

For best mass accuracy:

• Select a minimum of seven reference masses.

• Select peaks from different regions of the 
spectrum to ensure that high and low Mirror Ratios 
are represented. 

5. Click Solve and Plot to generate the calibration, then 
click Apply Calibration to save the calibration constants 
in the data file. Click Close.

6. Save the calibration file as ANGIO_PSD.CAL by selecting 
Export from the File menu, then selecting Calibration.

Adding PSD
calibration

1. Open the Angiotensin_PSD.BIC file that you renamed 
in “Setting PSD acquisition parameters” on page -6. 

2. In the PSD calibration section of the PSD Acquisition 
settings control page (see Figure 8-1 on page -7), select 
the ANGIO_PSD.CAL file you created in the previous 
section.

3. Select Save Instrument Settings from the File menu.

Acquiring PSD
segments with

PSD calibration

Reacquire PSD segments with PSD calibration as described 
in “Acquiring PSD segments” on page -8. Check the fragment 
ion masses to make sure they are within acceptable error.
Voyager™ Biospectrometry™ Workstation User’s Guide 8-13
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8.1.2  PSD Analysis of an Unknown

Generating the
Reflector mode

precursor
spectrum

This step assumes that you have already determined an 
accurate mass for the precursor ion using reflector mode 
high-resolution analysis with internal or external calibration 
(this analysis requires conditions that differ from PSD analysis 
conditions). You acquire the precursor ion again (using the 
same conditions you will use for PSD analysis) to generate a 
spectrum from which you can generate an external calibration. 
The external calibration you generate from the precursor ion is 
used to obtain maximum mass accuracy for the precursor ion 
during the PSD analysis, which helps ensure maximum mass 
accuracy for the fragment ions.

1. Open the PSD_Precursor.BIC file provided with the 
software. This is a reflector mode instrument settings 
(.BIC) file. All other instrument settings are identical to 
the settings in the PSD mode Angiotensin_PSD.BIC file 
you use to acquire segments.

2. Acquire using a laser intensity that does not saturate the 
reflector spectrum.

3. Save the precursor ion .DAT file by clicking  in the 
toolbar.

Generating an
external

calibration for the
unknown

precursor ion

To obtain maximum mass accuracy for the precursor ion, 
generate an external calibration file using the spectrum 
acquired in the previous section. You will use this external 
calibration when you perform the PSD acquisition. If you do 
not obtain maximum mass accuracy for the precursor ion 
during the PSD analysis, you will not obtain maximum mass 
accuracy for the fragment ions.

NOTE: This is not a PSD calibration that affects fragment 
ion masses. It is an external calibration that is applied 
before PSD analysis to ensure accurate mass of the 
precursor.
8-14 Applied Biosystems
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1. Click  in the Instrument Control Panel toolbar to open 
the precursor ion data file in the Data Explorer 
software. 

2. Create a single-point calibration using the precursor ion 
mass and save the calibration file as 
PRECURSOR_UNKNOWN.CAL by exporting the 
calibration constants from the data file. 

You may need to add the mass for the unknown to your 
calibration reference file before creating the 
single-point calibration.

For more information, see the Data Explorer Software 
User’s Guide, Section 5.3.2, Manually Calibrating.

Setting PSD
Acquisition
parameters

1. Open the Angiotensin_PSD.BIC file provided with the 
software. This is a PSD mode .BIC file.

2. In the Calibration section of the Instrument Settings 
control page, select:

• The matrix you are using.

• External File, then select the 
PRECURSOR_UNKNOWN.CAL file you created 
for the unknown in “Generating an external 
calibration for the unknown precursor ion” on 
page -14.

3. In the PSD Acquisition Settings control page:

• Type the accurate Precursor mass.

• In the Calibration section, select External File, 
then select the he ANGIO_PSD.CAL file you 
created in “Generating a PSD calibration” on 
page -12.

4. Select Save Instrument Settings As from the File menu, 
then save the instrument setting file with a new name.
Voyager™ Biospectrometry™ Workstation User’s Guide 8-15
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Acquiring PSD
segments

1. In the Manual Laser Intensity/Sample Positioning 
control page, select the same sample position from 
which you acquired the precursor spectrum.

2. From the View menu, select Data Storage. Set 
parameters as needed. See “Setting Data Storage 
parameters” on page 6-14, for information.

Hint: Include a _PSD suffix when you name PSD data 
files to help you distinguish them from non-PSD data 
files. For example, if you type in Experiment1_PSD as 
the file name, the complete data file name will be 
Experiment1_PSD.DAT or 
Experiment1_PSD_0001.DAT (if Autosequence File 
Names is enabled).

Selecting and
acquiring a

segment

3. In the PSD Acquisition Settings control page, select the 
row (click the number box in the Segment column) that 
corresponds to the segment you want to acquire.

4. To start acquiring, select Start Acquisition from the 
Acquisition menu, or click . 

5. Adjust laser intensity to optimize signal intensity. You 
typically need a higher laser intensity to optimize signal 
intensity for segments with lower Mirror Ratio settings.

The laser intensity needed for the first segment (the 
segment with the highest Mirror Ratio setting) is 
typically 150 to 200 counts higher than the laser 
intensity used to acquire the reflector mode precursor 
spectrum, and increases with each segment.
8-16 Applied Biosystems



Excerpted from Voyager 5.1 User’s Guide (4317707 Rev A 8/00)  PSD Quick Start

8

Examining and
saving the segment

6. Examine the spectrum to ensure that fragments are 
produced.

7. If fragments are present, click  in the toolbar to add 
the segment to the .DAT file. After you save the segment, 
the Saved check box in the segment list is checked.

If the current spectrum does not contain significant 
fragment ion signal and you do not want to save the 
spectrum, reselect the row and reacquire the spectrum, 
or select a new row.

CAUTION
Save the current segment (if the data is acceptable) 
before starting to acquire the next segment. If you do 
not, you will lose the data for the current segment.

Selecting and
acquiring

remaining
segments

8. Repeat step 3 through step 7 to collect remaining 
segments. 

NOTE: Segments are listed in the Data Explorer 
software in the order in which they are acquired. If 
segments with duplicate Mirror Ratios are contained in 
the file, the software uses the last acquired segment 
when it generates the composite spectrum.

Stopping the
experiment

9. After you acquire all necessary segments, select Stop 
Experiment from the Acquisition menu. The PSD data file 
is closed.

You cannot view the PSD data file in the Data Explorer 
software until you stop the experiment.

CAUTION
If you stop an experiment without saving any segments, 
no .DAT file is created.
Voyager™ Biospectrometry™ Workstation User’s Guide 8-17
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Confirming or
investigating
fragment ion

identity

To confirm or investigate fragment ion identity, you can use the 
following tools:

• If the peptide sequence is known—Use the Ion 
Fragmentation calculator in the Data Explorer software to 
apply fragment labels to the unknown composite 
spectrum.

For information, see the Data Explorer Software User’s 
Guide, Section 8.2, Applying Fragment Labels.

• If the peptide sequence is not known—Use the 
Peptide Fragmentation macro provided with the Data 
Explorer software to investigate the sequence in the 
unknown composite spectrum.

For information, see the Data Explorer Software User’s 
Guide, Appendix C, Data Explorer Toolbox (Visual Basic 
Macros).
8-18 Applied Biosystems
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